Using the Jabber Softphone

****Please note, the jabber softphone is not intended to be used to dial 911.
Please utilize a cell phone or home phone if applicable. Please ensure that calls
are NOT made to 911 through the Jabber softphone; you will not be connected to
your local 911 agency and this will result in a substantial charge that will be
charged to the Agency from the 911 service.****

Opening Jabber and Logging In

S

1. Launch the Cisco Jabber shortcut located on desktop — FEEEEEE

2. Use UPN format of username in this form: username@domain.state.mo.us
(domain will change to the current domain Agency is on such as ads, cdsor
bds) ex. woernd@bds.state.mo.us

3. Enter the password which is the same as logging into pc.

4. Click SignIn

Enter your username and password for Phone Services.

woernd@bds.state.mo.us

Forgot password?

5. Once logged in, go to the cogwheel top right; select Settings

8 — 0O % I
Q Search or call + File >
Settings
> A UC Support 0 Y% :
View >
> A UC Systems Help >

Sign out

6. Under Settings, General, check “Start Cisco Jabber when computer starts”

() Setings
General
Startup

Chats
n Start Cisco Jabber when my computer starts

Audio

Video
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Using Jabber as a Phone

Verify equipment has a microphone and Jabber has access to the microphone

Verify that the desktop/laptop has a microphone to use for calls. A headset can
also be used for placing calls. To check for a microphone, go to the Windows
search bar and type microphone —microphone settings should appear

1.

All Apps Documents settings

Best match

D Microphone privacy settings

System settings

Settings

)
o)

o)

Microphone setup

Turn off microphone access
systemwide

Turn off microphone access for all
apps

Choose which apps can access your
microphone

Turn on Speech Recognition

%] Find and fix problems with recording

sound

Photos

Page?2 |
H pel m\'crophone‘

In order for callers to be heard and hear, the microphone must be given
access to the Jabber application. Search for ‘microphone’ in the search
area.

Al Apps  Documents Settings

Best match

|:| Microphone privacy settings

=
System settings

Settings

O Microphone setup >

4 Tum off microphone access S
systemwide

 Tumn off microphone access for all S
apps

0 Choose which apps can access your >
microphone

& Tumn on Speech Recognition >

=] Find and fix problems with recording >
sound

= B

m\'crophcne\
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2. After locating microphone settings, click on Microphone Privacy Settings

Best match
Microphone privacy settings
L|;|J phone privacy 9: >
System settings
Settings
0 Microphone setup >
O Tumn off microphone access 5
systemwide
0 Tum off microphone access for all 5
apps
O Choose which apps can access your 5
microphone
O Tumn on Speech Recognition >
2] Find and fix problems with recording 5
sound
Page2 |
ﬂ O micronhonel

3. Make sure the ‘Allow Apps to access microphone’ is set to On

| Allow apps to access your microphone

f you allow access, you can choose which ap

e settings on this page. Denying access blocks

g your microphone

Verify PC/Laptop is set to use as phone

1. Next, verify Jabber is set to ‘use my computer’ for calls. In the lower left of
the Jabber screen, click on the small phone icon
& — 0O X
Q Search or call +
» AUC Support
> AUC Systems

> EUS HelpDesk

@ 5735222363 =]
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1. The screen will open. If desk phone is set up it will show both the option to
use desk phone (in this case the 8841) and use my computer - make sure to
select ‘use my computer’ in order to use the Jabber softphone.

% Device for calls

Lse my computer i
¥ P

< & Use my computer e
IE Cisco 8841

% Disable phone services

S

!
m
m'
m
i)

@ 5735222363 ~ =

Verify audio settings for speaker/microphone or headset

1. If the microphone and speakers will be used, users can verify the settings.
Click cogwheel at the top right, then settings.
B — 0O X I

Q Search or call + File >
Settings

> A UC Support s "

> A UC Systems Help >
S e aeean a e e Sign out

2. The default settings for the speaker/microphone usage are as below; note
the volume can be adjusted
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) Settings - X

General

Ringer/Alerts
Chats
= All Devices ~
Audio
Video
Mestings
Speaker
Calendar pe
Calle Speakers (High Definition Audio Device)  ~
Status
Location
Microphone
Notifications
Video Device Microphone (High Definition Audio Dev... ~
Privacy . @

Accounts 0

Appearance

Arrange devices on the advanced page.

@I €D €D

3. If a headset will be used, first plug the headset into the PC/laptop USB
port. Then click cogwheel at the top right, then click Settings.

Cisco Jabber 8 — O X!

Q search or call + File >

Seftings

» A UC Support

4. Click Audio Setting. The Ringer / Alerts is set to ‘All Devices’. For the
Speaker and Microphone — select the headset model (in this case Cisco
Headset)

e Note: With the desk phone select ‘all devices for the ringer’ then both the desk
phone and the softphone will ring when a call comes in even if ‘use my computer for
calls’ is selected. This gives the choice of which to answer. Select headset if there is
not a desk phone programmed.
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) Settings - X

General

Ringer/Alerts
Chats
A All Devices ~
Video 7
Meetings

Speaker
Calendar
Calls Speakers (2- Cisco Headset) pe e
Status 100
Location i i

Cisco headset settings
Notifications Firmware Version Reset

Video Device
Microphone

Privacy @

Microphone (2- Cisco Headset) -
Accounts

Appearance — 47

Making Calls

1. To place calls. Type in a number in the search field and click on thehandset
on the dropdown window that appears to dial. Dial 7 digits for calls within
the area code; 10 digit for calls outside the area code

Q 5735220087 ’—ﬁ_‘ +
cﬂﬁl’l"l"‘l ik —all
Call 5735220082 9

Search chat room messages

2. Another option to call a user is to right click on a contact and click call to
dial.
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~ A UC Support

K8 Banley Kristie
Chat
E Ca
8
Call with edit
RC ( Start meeting

@
e
@’

Schedule meeting
Send email

Ednt profile..

View profile
Move to group

Copy 10 group

>

Work : 5735225635

Work : Kriste,Badey@oa.mo.gov

3. Additional option to call a contact is to hover over a contact andclick
handset to dial.

o Bailey, Kristie

Available

=T

4. Search a name from the State Directory and click handset to dial

2 west, susa

2

o Angie...

sw, e 5@ @

5. To make a call from another line on the softphone, click on the dropdown
to see the available lines and click on the line to use to make outgoing calls.
This will place a check mark next to the selected line.
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9 > ‘vf"l..flaiarr?er, Darcy

Q a Agent Li...

All ~ 5735222363
Q ©

Marks, Ror o Agent Line 1036. | +

Receiving Calls

6. To receive a Call, a notification window displays on computer screen,click
one of the choices

@ Incoming call
@) 5735222363

e Eggen, Nick
T

‘Waork

End, Transfer, Hold, Mute, Conference a Call — use the Active
Conversation Window

The Active Window, More Call Control Button give additional functionality during

the call
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WOERNER DARCY
Q 5735220082 o8 (+ 0:00:58 @) 5735222363

[1] WOERNER DARCY

@ 5735222363 ~ A a @ . H . \

End the call. if you are in a conference call and you hang up, the other
- participatns in the conference can continue the conversation.

n Put the call on hold and retrive the call

Mute or unmute the caller.

444 Open the dial pad

@ Transer, Conference With, Chat, View Profile
Working on Share Desktop, Instant WebEx Meeting, Start My Video

Minimize active conversation window
= @ | [ - .
T (careful notto hit "X" and end conversation)

Ending a Call

1. To End a Call, click on the Red X button

# - 0
WOERNER DARCY
0:01:51 @ 5735222363 Qo
sl
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Placing a Call on Hold

1. To Place a Call on Hold, select the Active Window and click on the More Call

Controls button

@ — O X

WOERNER DARCY
0:20:11 §) 5735222363

000000
S

2. Then click on Hold

@ - 0 x

WOERNER DARCY
0:02:54 ) 5735222363 N

Hold

Transfer
Conference

3. Click on Resume to resume call

WOERNER DARCY
0:12:44 @ 5735222363

WOERNER DARCY
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Transfer a Call

1. To Transfer a Call, click on the Active Window, select More Call Control

& — 0O X

WOERNER DARCY
0:20:11 @ 5735222363 &

2. Then select Transfer

# — 0O x

WOERMER DARCY
0:02:54 ) 5735222363 o

Hold
Transfer
Merge

Conference

3. Type a number or search for the name of whom to transfer to — click onthe

green handset

Transfer to

Q angie craig [}

Contacts and recents

Craig, Angie
= Away
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4. Then click transfer —the call can be announced when party answers or do a
blind transfer.

WOERNER DARCY Craig, Angie
On hold Calling...

Transfer

5. To not do a transfer, click the red X to cancel the transfer and get call back

'WOERNER DARCY
0:12:08 @) 5735222363

WOERNER DARCY “UC Help Desk”
On hold Calling...

6. Then resume call

# — 0O X

WOERNER DARCY
0:12:44 @ 5735222363 Qo

WOERNER DARCY
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Conference Calling

1. To Conference another caller into a call in progress, click on the Active
Window, select Call Control button

# — 0O X
Eggen, Nick
0:00:09 € 5735222363 o
&
2. Then select Conference
& — 0O X
Eggen, Nick
0:01:08 @ 5735222363 o

Hold
Transfer
Merge

Conference

000000
o

Thanks Darcy.
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3. The screen shows the field to invite additional conference participants

Conference
0:00:28 @) Darcy Woerner 5222363 0 <&

] Q invite participants
Q Woerner, Darcy
e Eggen, Nick

R

4. Search for the participant, and click on name

Conference
0:00:55 ) 5735222363 O
=) Q sean nort [}
Contacts and recents

Northweather, Sean
= Available

gy s e
In conference
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5. Then click on the green handset by ‘call to join’ (if the green phone handset
does not appear right click on name and select ‘call’)

& —

Conference
0:01:28 @) 5735222363 O &

Woerner, Darcy

In conference

Eggen, Nick

In conference

Northweather, Sean
Cali to join

D00 -

2

6. When the additional party answers call, click on the green icon next tothe
‘waiting to join’

Conference
0:02:20 @) 5735222363 O

] Q Invite participants
Woerner, Darcy
In conference
Eggen, Nick
In conference

Northweather, Sean
Waiting to join
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7. Now the parties are joined ‘in conference’

& — 0O X
Conference
0:03:38 05735222363 O n

=] Q Invite participants
Woerner, Darcy
In conference
Eggen, Nick
In conference
Northweather, Sean
In conference

ot

8. If the green icon for ‘waiting to join’ did not appear, click on the call control
button and ‘merge’ the participants

Hold
Transfer

Merge J Eggen, Nick

Conference
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Hunt Groups

1. Hunt Group members can check status and log the Jabber softphone inand

out of the Hunt Group using the Hunt Groupicon.
Note ‘use my computer for calls’ must be selected. If a desk phone is also programmed, logging
in and out of the Jabber softphone does not affect the login/out for the desk phone — the desk

phone must be logged in/out separately.

Q. 5735220082 (<] +

> A UC Support

> A UC Systems

yal

> CES Help Desk

Hunt Group

i, Unt aroup 1s 1oggedc ora =1
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3. Jabber acknowledges the logout

paEiEE N E T l &) Hunt groups X
You have been logged out of your hunt |
groups

Hunt Group

4. To loginto the Hunt Group for the soft phone, select login

Hunt Group
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Forwarding phone line using Jabber

1. Locate phone icon and click on it

& — 0O X
Q Search or call +
> A UC Support
> A UC Systems
~ CES Help Desk
' Grellner, Jennifer
Q Schaffer, Nancy
S Offline
@ s5735222363(Dary... v 5]
2. Select the phone line to forward
% Device for calls
E Use my computer w
- Forward Calls
Mone -
) Linel: 5735222363 " MNone
Line2: Agent Line 1036333 b Voicemaill
@ 5735220363 ~ O Newnumber..
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3. The line can be forwarded straight to voicemail or a new number; if new
number then type in the number and click on forward (remember the
number to forward to should be another UC line or business cell phone)

* A UC Support

» A UC Systems

» CES Helj &) Forward calls to W

s

L

735264111

4. System acknowledges the forward — click on the forwarding alert to turn off

Q ang o +
* A UC Support

» A UC Systems

> CES Help Desk D %
Line 1 forwarded to : Craig, Angie
Click to turn off
@ 5735222363 ~ Y
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Softphone on Home Network

When working from a home network, there is not a simple set of minimum
network speed or connection requirements that will guarantee successful
connections when working with a home internet. Depending on each
person’s internet usage, the requirements can vary.

Below are a couple of things to consider:

- How many devices are being used on the home network? The more
devices (eg. video streaming, PCs / tablets / mobile phones) will affect both
applications and Jabber phone calls. If slowness or voice quality are
experienced, some devices may need to be powered off to see if this will
resolve the issue.

- Network bandwidth can vary by internet service providers. For
instance, a provider offering 10 Mbps service may refer to the speed
available to download, while there is only 1Mbps available to upload
information back to the internet. In this case, a user may experience no
issues with receiving files or emails, but sending files or emails may be very
slow. If a user places a call, they may hear the caller with no issues, butthe
caller may not be able to hear them or it may be very broken. In this case,
the user may need to talk with their internet service provider to request a
service with higher upload speed connection back to the internet.

It is always recommended to place several test calls during what may be
the heaviest internet usage on their home network. If there are
intermittent issues with the quality or speed of the connectivity, the
internet service provider can assist with determining the current
utilization on the network connection.
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